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Predgovor

Ovaj zavrsni rad temelji se na osobnom interesu u 3D modeliranje i dizajn. Cilj je bio steci
nova znanja na podrucju trodimenzionalnog modeliranja i dizajniranja te spojiti ova dva
dijela multimedije u jedno. Tako je zahvaljujuéi interesu prema trodimenzionalnom
modeliranju, dizajniranju i lokalnoj legendi o zmaju Pozoju nastala inspiracija za ovaj zavrs$ni

rad.

Ovim putem zahvaljujem se mentoru, dipl. inf. Andriji Berniku na pruzenoj pomodi i

savjetima u izradi ovog rada te svojoj obitelji na razumijevanju i podrsci.



Sazetak

Animirani filmovi su, bas kao i igrani filmovi, plod necije maste ograni¢en potrebnim mu
resursima. No neki od najboljih filmova, poput ,,Deadpool““-a, nastali su upravo zahvaljujuci
necijem znanju 1 moguénostima u trodimenzionalnom modeliranju. Trodimenzionalno
modeliranje ve¢ dugi niz godina omogucuje stvaranje virtualnih likova, objekata i svijeta te
se s godinama unaprjeduje i daje izvanredne rezultate. Jedan od najkoristenijih alata za 3D
modeliranje je Autodesk Maya. Stoga je u radu opisan postupak izrade 3D scene koriStene za
imaginarni animirani film unutar Autodesk Maye koja je kasnije koriStena za izradu filmskog
plakata. Osim Maye, koristen je i Adobe Photoshop kako bi se teksture modela bile §to bolje.

Kako bi se dobili sto realniji rezultati koristen je Mental Ray render.

Kljuéne rije¢i: 3D modeliranje, Adobe Photoshop, animirani film, Autodesk Maya,

filmski plakat, Mental Ray
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1. Uvod

Trodimenzionalno modeliranje je proces izrade trodimenzionalnih modela, stvarnih ili
imaginarnih, pomoc¢u nekog 3D programa. Primjenom trodimenzionalnog modeliranja,
stvoreni su brojni konceptualni modeli u industriji, rekonstruirani mnogi fosili za arheologe,
stvoreni virtualni likovi, objekti i svijet u zabavnoj industriji te uz pomo¢ 3D printera
nadomjestene kosti Covjeka u medicini. 3D modeliranje stvorilo je stoga veliku prekretnicu u

ljudskom zivotu.

Jedan od programa koji se koristi u profesionalne i amaterske svrhe za trodimenzionalno
modeliranje je Autodesk Maya. Pomoc¢u ovog programa moguce je stvoriti 3D modele na tri
nacina, poligonalno, subdivizionalno ili NURBS modeliranje, a na korisniku je da odabere
koju ¢e metodu izabrati. Takoder, Maya nudi pregrst alata 1 opcija kako bi model izgledao Sto
vjernije zamisljenom. Pomoc¢u dodatnih programa poput Adobe Photoshopa, moguce je
stvoriti teksture modela kojima se model moze dodatno usavrsSiti, a da bi model izgledao $to
realnije postoje razne metode renderiranja. Jedna od najboljih metoda je renderiranje pomocéu
Mental Ray-a. Mental Ray je render koji omoguéava veliki broj postavki i opcija te daje
najrealisti¢nije rezultate. Pomocu njega moguce je stvoriti prirodno i umjetno osvjetljenje te
generira osvjetljenje sunca i neba. Generiranje odnosa sunca i neba posebice je korisno pri

renderiranju eksterijera i1 stvaranju efekta realisti¢nosti.

No da bi model bio §to bolje predstavljen, treba ga promatrati i u umjetnickom smislu te
paziti §to on predstavlja. Ako se radi o proizvodu, da slika predstavlja taj proizvod i prikazuje
ga kao najboljeg, ako se radi o nekom liku, pripaziti da su naglasene sve njegove prednosti ,
ako se renderira scena, da ona bude $to realisti¢nija. Do ovog problema dolaze i kreatori u
zabavnoj industriji. Da bi $to vjernije prikazali scenu ili lik moraju pripaziti na veliki dio

stvari, od modeliranja, teksturiranja pa sve do renderiranja.



Upravo iz interesa prema modeliranju, dizajnu i filmovima, javila se tema ovog zavr$nog
rada. Cilj je spoznati nove tehnike modeliranja i dizajna te ih povezati u jedno. Stoga bi se
moglo reci kako se ovaj rad dijeli u tri velike cjeline, modeliranje, teksturiranje i renderiranje,
odnosno izradu plakata. Ovaj rad prikazuje osnove koje su potrebne kako bi se Sto bolje
shvatio rad sa programima Autodesk Maya i Adobe Photoshop i njihovim mogu¢nostima. U
ovom slucaju, dizajn je predstavljen izradom $to boljih i originalnijih filmskih plakata. Kroz
primjere prikazani su najkoristeniji alati u Mayi, teksturiranje u Photoshopu i renderiranje
Mental Rayom. Svo znanje §to je predstavljeno u radu, koristeno je pri izradi prakti¢nog rada
kako bi se stvorila scena za imaginarni animirani film predstavljen filmskim plakatom, ¢ija se

ideja temelji na lokalnoj legendi 0 zmaju.



2. Trodimenzionalno modeliranje

Trodimenzionalno modeliranje, odnosno 3D modeliranje je proces stvaranja stvarnih ili
imaginarnih objekata i prostora, a sam produkt naziva se trodimenzionalni model (3D
model).[1] 3D model je zapravo skup svih potrebnih informacija i podatka o tockama 3D
prostora koje racunalo interpretira u virtualni objekt. Unato¢ pregrst tehnika i metoda kojima
se mogu stvoriti trodimenzionalni modeli, modeliranje i kreiranje novih 3D modela svodi se

na tri klasi¢na nacina:

1) Modeliranje uz pomo¢ programa — nacin stvaranja modela u programu za

modeliranje kao $to su Autodesk Maya, Blender, SketchUp i 3ds Max

2) Modeliranje skeniranjem — nacin stvaranja modela skeniranjem stvarnih
objekata. Objekt se najprije skenira i zatim se pretvara u format koje racunalo i

sam program za modeliranje prepoznaju

3) Proceduralno 3D modeliranje - predstavlja nacin stvaranja modela uz pomoé

algoritama.

3D modeliranje se vrlo ¢esto koristi za izradu prototipova u raznim industrijskim granama,
od modne preko automobilske pa sve do prehrambene industrije. Posebice je znafajno u
medicini gdje se svakim danom usavr$ava kako bi se, koriste¢i metodu 3D ispisa, jednog

dana mogli zamijeniti bolesni organi i dijelovi tijela.

Siroku primjenu, 3D modeliranje je takoder naslo u filmskoj industriji i industriji video
igara gdje se kombiniraju¢i sa raznim tehnikama uvodi u sam film ili igru. Od 1976. [2]
godine pa sve do danas, upotreba 3D modeliranja i same 3D racunalne grafike u filmskoj
industriji se znatno povecala te se sve viSe primjenjuje kako bi se Sto vjernije prikazali

imaginarni likovi i virtualni prostor i objekti.



2.1. Autodesk Maya

Autodesk je dobro poznati program u trodimenzionalnom modeliranju, inzenjerstvu i
zabavnoj industriji.[3] Od samog osnutka pa do dan danas, Autodesk Inc. nastavlja
svakodnevno razvijati programe potrebne za 3D modeliranje. Jedan od tih programa je i
Autodesk Maya.

Autodesk Maya je raCunalni program namijenjen 3D modeliranju, teksturiranju,
renderiranju, animiranju i simulaciji za sve ljubitelje animacije i 3D modeliranja. Prvu verziju
Maye, Maya 1.0, razvio je Alias Wavefront 1998. godine, a sedam godina kasnije ona je
postala dio Autodesk programa te poprimila dana$nji naziv ,,Autodesk Maya“. Od osnutka pa
do danas, Maya se uvelike koristi u filmskoj industriji i industriji video igara. Pomocu nje
stvoreni su neki od nagradivanih filmova kao S$to su ,,Rango” i ,,Hugo* te neke od
najpoznatijih videoigara kao $to je ,,Call of Duty“. Zbog toga se Maya vrlo esto koristi u
spomenutim industrijama prilikom 3D modeliranja, dodavanja vizualnih efekata, ra¢unalne

grafike i animiranja virtualnih likova.[4]

Sav rad u Mayi zapravo se svodi na nekoliko kategorija: [5]

1) Modeliranje i teksturiranje
2) Animiranje

3) Simulacije

4) Specijalni efekti

5) Rasvjeta i sjencanje

6) Renderiranje



2.1.1. Modeliranje

3D tehnikama modeliranja korisnik moze izraditi 3D model na nekoliko nacina, koriste¢i

poligone, krivulje (NURBS-e) ili hibrid dvaju spomenutih tehnika pod nazivom

subdivizionalno modeliranje. [1]

1)

2)

3)

Polygons

Slika 2.1. Tri tehnike modeliranja [6]

Poligonalno modeliranje (eng. Polygons) — Omoguéuje modeliranje pomocu
jednostavnih poligona kao §to su kocka (eng. Cube), kugla (eng. Sphere), valjak (eng.
Cylinder), stozac (eng. Cone) i piramida (eng. Pyramid). Takoder je moguc¢e modeliranje
pomocu ploha (eng. Plane) koje se zatim spajaju u zajednickim tockama. Trostrane i
Cetverostrane plohe (poligoni), su najées¢i elementi poligonalnog modeliranja. No §to je
model sastavljen od vise poligona to je veli¢ina datoteke veca S§to moze znatno usporiti

rad procesora racunala. Najéesée se koriste za kreiranje modela u video igrama. [7] [8]

NURBS modeliranje (eng. Non-Uniformal Rational Bezier Splines) — NURBS je
zapravo matematicki izraz koji 3D modele prikazuje pomocu krivulja i povrsina. Temelji
se na Bézierovim krivuljama koje program automatski iscrtava izmedu kontrolnih tocaka
(eng. CV = Control Vertex). Dodavanjem vrhova u krivulju dobivaju se nove tocke za
manipulaciju, a krajnji rezultat je glatka povrSina bez nazubljenih vrhova. Za razliku od
poligona oni se viSe koriste za dizajn i CAD (eng. Computer-aided Design = dizajn

potpomognut raunalom) modeliranje. [7] [8]

Subdivizionalno modeliranje — Predstavlja kombinaciju poligona i NURBS-a. Proces
zapocinje modeliranjem poligona na kojima se zatim primjenjuje matematika NURBS-a
kako bi se grubi rubovi modela zagladili. Ovakvi modeli mogu se teksturirati gotovo lako

kao poligon, a koriste se najcesce za visokokvalitetne vizualne efekte. [7] [8]



2.1.2. Teksturiranje

Teksturiranje trodimenzionalnih modela je proces dodavanja boja i svojstva samom
nacina teksturiranja 3D modeliranja sa svojim svojstvima te nekoliko vrsta materijala koji se
mogu Koristiti. Postoji nekoliko osnovnih materijala, no najéesc¢e koristeni su Lambert, Blinn,

Phong, Ramp Shader i Anisotropic.

Osim ovih osnovnih materijala postoje i dodatni, realistiéni materijali koji se mogu
ukljuciti u dodatnim opcijama poput Mental ray materijala. Osim materijala, postoje i razliciti
izbornici za teksturiranje, a najvazniji su Attribute Editor, Hypershade i UV Texture Editor.
U Attribute Editoru se odreduju osnovne postavke materijala sa specijalnim efektima i
postavkama za renderiranje. U Hypershade izborniku se prikazuju sve veze izmedu materijala
I teksturnih mapa na sceni, a u UV Texture Editoru se prikazuje mapa koja je mapirana na 3D
model i raspored UV toc¢aka. To mapiranje moze biti sferi¢no, cilindri¢no, kubi¢no, planarno

i UV mapiranje. [9]

Slika 2.2. Osnovni materijali



Tablica 2.1. Vrste i opis osnovnih materijala

Materijal bez sjaja koji se po osnovnim postavkama nalazi na svakom

Lambert modelu.
Sjajni 1 reflektiraju¢i materijal koji se najées¢e koristi za objekte koji
Blinn predstavljaju metal ili ogledala, a njegova svojstva se mogu podesiti po
potrebi.
Sjajni materijal s oStrim osvjetljenjem koji se najée$ée primjenjuje na
Phong : . o . .
modelima stakla i automobila, ¢ije se postavke mogu podesiti po potrebi.
Materijal koji ima mogucénost dodavanja neograni¢enog broja boja i
rijelaza koji se mogu kontrolirati mijenjanjem svijetla i kutom pogleda te
Ramp Shader prij ,.J g . ..JJJ..V.J . hog
omogucuje dodavanje materijala i njegovo mijeSanje sa bojom.
Materijal kod kojeg dolazi do postepenog prijelaza boja kao Sto se moze
Anisotropic ! )8 POSEPENOg PT !

vidjeti na optickim diskovima, peru ili tkaninama poput svile ili satena.

*  mib_illum_blinn

+ mib_illum_hair

mib_illum_lambert

* mib_illum_phang

Slika 2.3. Mental Ray materijali




2.1.3. Animiranje i specijalni efekti

Animiranje je jo$ jedna moguénost Autodesk Maye zbog ¢ega ovaj program ima sve vecu
primjenu. Tome svjedocCi i Cinjenica da su u proteklih pet godina Autodesk Mayu vece
filmske kompanije, poput Pixar-a, prihvatile kao svoj standard za izradu animiranih 3D
efekata. Unutar samog programa mogu se animirati modeli sa svojim teksturama, bojama
intenzitetom svijetla i slicno. Sami likovi animiraju se uz pomo¢ kostura (eng. Skeleton) sto

im daje moguc¢nost gibanja i postavljanja u razne poze.

Animacijska traka sastoji se od nekoliko kontrola s kojima se radi animacija. Najvaznije

kontrole animacije su kliza¢ za vrijeme i opseg.

Bed 14 |« 4 & »| ] ]

Slika 2.4. Animacijska traka

Animacija se stvara postavljanjem klju¢nih okvira gdje su 24 okvira jednaka jednoj
sekundi. Broj okvira odreduje se s obzirom na vlastiti izbor, a oni se zatim zakljucavaju u
vremenskoj crti. Osim klju¢nih kadrova, postoje i razni animacijski parametri koji su klju¢ni
za animaciju. Oni ponajvise utjeCu na nacin reprodukcije animacije i na pogled i rad s
vremenskim slijedom. Graph Editor je prozor u kojem se nalazi graficki prikaz animacije koji
omogucuje uredivanje, kopiranje i ponavljanje animacije (eng. loop) i kljuénih kadrova. Osim
njega, kljucne kadrove moguce je uredivati pomocu prozora Dope Sheet koji omogucuje
pomjeranje, povecavanje, kopiranje, ubacivanje i sl. kadrova u samom prozoru i u liniji
vremenskog slijeda. [10] Unutar Autodesk Maye takoder postoje ve¢ gotovi efekti koji se
koriste kod vizualnih efekata i simulacija. NajceS¢e koriSteni efekti su eksplozije, pozar,

tekucine, kosa i sudaranja.




2.1.4. Osvijetljenje

Jedan od klju¢nih elemenata scene je osvjetljenje. Osvjetljenje, odnosno rasvjeta,
kontrolira izgled, atmosferu i vidljivost na sceni. Svi modelirani objekti i likovi mogu se
osvijetliti sa Sest razliCitih izvora svijetla koji u kona¢ni imaju mnogo sli¢nosti sa
osvjetljenjem koje se koristi za filmove. Stoga se za pravilno osvjetljenje preporuca
koriStenje principa kao kod fotografiranja ili snimanja filmova. Svako od ovih osvjetljenja

ima svoje specificne karakteristike ¢ime odreduje razli¢ite uvjete osvjetljenja.[12] [13]

Tablica 2.2. Vrste i opis svjetla

Svjetlo koje proizvodi ravnomjernu, neusmjerenu svjetlost u cijeloj

Ambient Light o . . . . .
g sceni. Svjetlo koje nema ocigledan izvor 1 ne stvara sjene .

Zrake svjetla koje ravnomjerno osvjetljavaju scenu iz jednog pravca.
Directional Light To omogucava stvaranje sjena i isticanje pojedinog dijela modela.
Najces¢i primjer takvog svijetla su sunceva ili mjeseceva svjetlost.

Svjetlost koja proizlazi iz samog centra u svim pravcima. Sto se
Point Light objekt nalazi dalje, to ¢e biti slabije osvijetljen ¢ime ono stvara
sjene. Primjer takvog svijetla su LED diode, baklje i razne sijalice.

Svjetlo koje proizlazi iz stoSca ¢ime osvjetljava prostor unutar
usmjerenog podrucja i stvara sjene na modelu. Dodatna mogucnost
Spot Light je podesavanje Sirine, unutarnjih i vanjskih kutova osvjetljenja Sto ga
¢ini izvrsnim za postizanje dramati¢nog efekta. Primjeri ovog svjetla
su uli¢ne lampe, baterije, reflektori i farovi automobila.

Osvijetljenje proizlazi iz pravokutnog izvora odnosno odraza svjetla
Area Light na zidovima, a naj¢escée su to osvijetljeni paneli i fluroscentna
osvjetljenja.

Zrake svjetla koje proizlaze iz slabih izvora kao §to su baklje ili vatra

Volume Light .
g te prolaze kroz neki prostor.




Slika 2.6. Razli¢iti izvori svjetla

10



2.1.5. Renderiranje

Kad se scena namjesti, teksturiraju svi modeli, postavi osvjetljenje i definiraju sjene,
postavi se kamera i na red dolazi renderiranje. Renderiranje je proces pretvaranja
trodimenzionalne scene u sliku ili video koji zahvaljuju¢i svim navedenim koracima ¢ini
scenu realisticnijom. Unutar Autodesk Maya postoje tri osnovne vrste renderiranja: Maya

Software, Maya Hardware i Maya Vector te dodatna vrsta Mental Ray.

Tablica 2.3. Vrste i opis rendera

Render koji se moze povezati sa svim dijelovima Maya programa.
Stvara slike visoke kvalitete sa osvjetljenjem, sjenama, teksturama i
zamucivanjem pokreta te omogucuje pracenje zraka odnosno refleksiju i
refrakciju.

Maya Software

Render koji za kona¢nu sliku koristi graficku karticu, a njegov rezultat
su slike sli¢ne kvalitete kao kod 3D video igara. lako omogucava brze
renderiranje, nedostaje mu mnostvo postavki i daje slabiju kvalitetu slika
od software rendera. [15]

Maya Hardware

Render koji omogucava renderiranje u ilustracijskom i crtanom obliku te

Maya Vector | oo oristi kod stiliziranih slika formata TIFF, IFF i Al [15]
Render koji je po funkcionalnosti slican renderu Maya Software, ali daje
uno realisticnije slike 1 omoguéava namjeStanje mnogo postavki
Mental Ray P ) 8 ) ) £° P

ukljucujuéi kaustiku i globalno osvjetljenje te generiranje fizickog sunca
I neba unutar same scene.

Edit Presets Help

Render Layer masterLayer -

Render Using Maya Software
Maya Software

Common
naya/ projects | default/images/
Image size: 640 x 480 (8.9 x 6.7 inches 72 pixels/inch }

¥ (Color Management

Enable Color Management

Slika 2.7. Izbornik rendera u Autodesk Maya 2012.
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3. 3D modeliranje i film

U danasnje doba prepunom napredne tehnologije, 3D modeliranje je usko povezano sa
filmskom industrijom. Ono $to prozivljavamo kroz svijet filma ili videoigara jest to $to
pokre¢e 3D industriju. Veliku prednost tome pridodaje i Cinjenica da se za stvaranje novih
filmova, bilo igranih ili animiranih, vise ne treba tro$iti puno novaca ve¢ je potrebno samo
znanje i vrijeme, bilo da se radi o0 modeliranju i dodavanju scene ili pak integriranju likova.
Neki od najkoristenijih programa za 3D modeliranje su 3D Studio Max, Autodesk Maya, Soft
image XSI i ZBrush. [16]

Poslije

Slika 3.1. Koristenje 3D tehnika u filmu ,,Deadpool* [17][18]
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3.1. Animirani film

Animirani film ili kra¢e animacija je svako djelo u kojem se dojam kretanja postize na
umjetan nacéin, bez obzira na koristenu tehnologiju ili nacin stvaranja faza kretanja. No pod
pojmom animacija smatra se i sam proces animiranja, odnosno pridavanja pokreta nekoj
pojavi, npr. animacija kretanja lika. Kao i kod igranih filmova, i u animiranom filmu lako se
raspoznaju likovi, njihovi postupci i ambijent u kojem se nalaze te jasno predocavaju prizore
i zbivanja u odredenom redoslijedu. Za njegovo stvaranje koriste se razne tehnike i razni
programi kako bi on nastao te postoji odredeni proces njegove izrade. Zahvaljujuéi mediju
televizije, animirani filmovi postali su dio nase svakodnevice. U animirane filmove pripadaju

crtani filmovi, lutkarski filmovi i svi oni filmovi u kojima se animiraju nezivi predmeti. [19]

L
!
(5] 3
§

-y . ~ —
vl." s wia Nl . 2 e =2

Slika 3.2. Izrada 3D animiranog filma ,,Madagaskar*[20][21]
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4. Adobe Photoshop

Adobe Photoshop, ili kra¢e Photoshop, je ra¢unalni program namijenjen grafickoj obradi
fotografije. Razvila ga americka tvrtka Adobe Systems 1990. godine. Photoshop je vodeci
program u svijetu obrade fotografija zahvaljujuéi svojoj fleksibilnosti 1 potpunoj kontroli
tokom rada sa neobradenim slikama. Pomoc¢u njega moguce je obraditi postojecu fotografiju
ili stvoriti neSto iz svoje maste od jednostavne obrade svijetla i boje do spajanja vise

fotografija.

"+
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Slika 4.1. Korisni¢ko sucelje Adobe Photoshopa CS6

Photoshop se danas koristi u mnoge svrhe. Od kreiranja plakata, preko web stranica do

mobilnih aplikacija te kreiranja filmova i trodimenzionalnih fotografija. Moguénosti
Photoshopa CS6 su: [22]

1) Osnovne korekcije slike

2) Rad sa selekcijama i slojevima
3) Rad s maskama i kanalima

4) Tipografski dizajn

5) Vektorsko crtanje

6) Rad s kompozicijama

7) Uredivanje video zapisa

8) Rad sa 3D slikama

9) Priprema datoteka za web
10)Priprema za tisak
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4.1. Osnovne korekcije slike

Govore¢i o osnovnim korekcijama slike najceSce se govori o retuSiranju. RetuSiranje je

zapravo obrada digitalne fotografije, bilo da se radi o sitnom detalju ili cijeloj fotografiji. U

osnovne korekcije slike spadaju mijenjanje veli¢ine i rezolucije slike, izoStravanje, uklanjanje

nezeljenih dijelova te mijenjanje boja, zasi¢enosti, svjetline i kontrasta.

Kako bi se promjena desila na pojedinom djelu slike vrsi se selektiranje tog djela. Postoje

Cetiri skupine alata za selektiranje: [22]

Tablica 4.1. Vrste alata za selektiranje

Geometrijske selekcije

Alati koji koriste geometrijske oblike kvadrata (Rectangular
Marquee Tool) i kruga (Elliptical Marquee Tool) za selektiranje te
omogucavaju selektiranje jednog reda visine (Single Column
Marquee Tool) ili sirine (Single Row Marquee Tool) piksela.

Selekcije slobodnom
rukom

Alati kojima se selektira odredeni dio slike po volji. Njima se
omogucava slobodno selektiranje dijela slike (Lasso Tool),
postavljanje vezivnih tocaka (Polygonal Lasso Tool) ili
kombinacija ovih tehnika (Magnetic Lasso Tool).

Selekcije zasnovane na
rubovima

U ovu skupinu spada alat Quick selection Tool koji automatski
traZi 1 prati definirane rubove na slici.

Selekcije zasnovane na
boji

Alati koji selektiraju odredeni dio ovisno o njegovoj boji. U ovoj
skupini nalaze se Quick Selection Tool i Magic Wand Tool.

Slika 4.2. Promjena boje kiSobrana i remena[23]

15




4.2. Rad saslojevima

Svaka datoteka u Adobe Photoshopu ima najmanje jedan pocetni sloj (eng. Layer), a svi
novi slojevi su transparentni sve dok se na njemu ne napravi neka promjena. Slojevi
omogucuju rad na pojedinim dijelovima slike bez da se utjeCe na drugi dio koji se nalazi u
novom sloju. Tako se slojevi mogu dodavati, izmjenjivati, premjestati i brisati utjecavsi samo

na konacan rezultat slike.

Osim u slojevima, promjene se mogu raditi u maskama(eng. Mask) i kanalima (eng.
Channel). Maske stite pojedine dijelove slike koji se ne mijenjaju. Maske se rade na osnovi
selekcije, a sve ono $to nije selektirano je maskirano, odnosno zasti¢eno od bilo kakvog
mijenjanja. Moguce su privremene ili brze maske i trajne maske. Za razliku od maski, kanali
¢uvaju informacije o bojama na slici te se ne mogu tiskati. Klju¢na stvar u radu s maskama je

ipak da crna boja skriva, a bijela otkriva dio slike, a sivi ili Alfa kanali mogu se sacuvati. [22]

Original Image | Mask unwanted areas RVUEEIGE Image

Slika 4.3. Rad s maskom [24]
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4.3. Tipografija

Tekst u Photoshopu se sastoji od matematicki definiranih oblika koji opisuju slova,
brojeve 1 simbole jednog fonta. On se moze urediti na razne nacine, od promjene veli¢ine 1
fonta, preko boja pa sve do pozicioniranja te pisanja po putanji. Za razliku od Adobe
llustratora, u kojoj su slova prikazana vektorima, u Adobe Photoshopu se slova sastoje od
piksela u istoj rezoluciji u kojoj je i datoteka slike prilikom ¢ijeg povecavanja je moguce

vidjeti nazubljene rubove na slovima. [22]

VECTOR GRAPHICS BITMAPPED (RASTER) GRAPHICS

e
é e L

Slika 4.4. Vektorska i piksel(bitmap, rasterska) grafika [25]

&
& = )
:S’Q i & NS e
2 O) a Ce == A
~ E Q T ee— A
A §
; /"'A‘@ g
% % i~ //ﬂgh\& \
o o 943@1&9
iz "
o'over{(@ g (Curds and Wl’eg?
o,
SO W)

o,
ut panca\ccfﬂ

Slika 4.5. Tekst na raznim putanjama [26]
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4.4. Vektorsko crtanje

Za razliku od rasterske grafike, vektorska grafika sadrzava glatke rubove pri svakoj
promjeni veli¢ine Sto znaci da se oblici 1 slike mogu beskonaéno puta uvecati bez da gube na
kvaliteti. Unutar Adobe Photoshopa mogucée je raditi sa obje vrste grafika ¢ak i istovremeno.
Osnovna razlika je to da se bitmap grafika (rasterska ili piksel grafika) zasniva na mrezi
to¢aka, odnosno pikselima, koje imaju svoj polozaj i sadrze informacije o boji te se tako
zapravo ureduju grupe piksela, a ne oblici i objekti. VVektorska grafika se temelji na vektorima
Ciji se oblici sastoje od pravih i zakrivljenih linija. Crtanje vektora se u Photoshopu radi
pomocu alata Pen Tool kojim se najpreciznije mogu raditi trazene putanje. Vektorska grafika

se najcescée koristi pri izradi ilustracija, teksta i grafi¢kih objekata poput logotipa.[22]

b

I’'ma bitmap. I’'ma vector.

Slika 4.6. Piksel i vektorska grafika [27]

N §* Pen Tool
; #"‘ Freaform Pen Toal
+ﬂ\ Add Anchor Point Tool

—ﬂ\ Delete Anchor Paint Tool
[*. Convert Paint Tool

Slika 4.7. Pen Tool paleta

18



4.5. Uredivanje video zapisa

lako je primarno namijenjen obradi fotografija, Photoshop pruza i mogucnost obrade
video zapisa. Za njegovu obradu moze se koristiti veliki broj efekata koji se koriste kod
uredivanja slika, a film se moze kreirati i dodavanjem slika, video i audio zapisa i slojeva s
tekstom kao i raznih prijelaza i efekata izmedu njih. Kao i kod obi¢nog videa, i ovdje je
potrebno kreirati klju¢ne kadrove. Kljucni kadar je kadar koji biljezi trenutak u vremenu kad
je odredena neka vrijednost poput veli¢ine ili poloZaja, a da bi se izvrSile promjene na njima
moraju postojati najmanje dva klju¢na kadra kako bi postojao jedan original i jedan kadar sa

promjenama.[22]

PS File Edit Image layer Type Select Filter 3D View Window Help
=l 5 B Mode: | Normal 3 opacty: 100% [T @ Fow 100% 7| (A

runcycle.psd @ 66.7% (RGB/8#) [scaled] * x
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Slika 4.8. Izrada videa u Adobe Photoshopu CC [28]
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4.6. Rad sa 3D slikama

Trodimenzionalne moguénosti Photoshopa dostupne su svim korisnicima ukoliko njihova
video kartica podrzava OpenGL 2.0 koji je aktiviran na njihovom rac¢unalu. Ukoliko OpenGL
nije podrzan ili se koristi Windows XP operativni sustav, 3D moguénosti nece biti moguce
koristiti. Kao i kod svakog programa, i u Photoshopu se nalazi ve¢ nekoliko gotovih 3D
geometrijskih oblika te oblika svakodnevnih predmeta, poput prstena, kojima se moze
mijenjati poloZaj 1 veli¢ina. Ovakav objekt nalazi se u posebnom sloju. Za razliku od obi¢nih
slojeva, 3D sloj se sastoji od jedne ili vise mreza koje definiraju 3D objekt te sadrzi i jedan ili

viSe svjetlosnih efekata koji utjeCu na izgled 3D objekata.[22]

® Photoshop File Edit Image Layer Type Select Filter 3D View Window Help
Adobe Photoshop CS6

Auto-Select: [Layer +

* Untitled-1 @ 100% (glass, RGB/8) *

glass Front Bevel Material

¢ glass Extrusion Material

& glass Back Bevel Material

¥ Catch Shadows

¥ Cast Shadows

| Shape Preset Deformation Axis:

n Reset Deformation

Texture Mapping: Scale

Doc: 1.59M/3.19M

Slika 4.9. 3D model ¢ase u Adobe Photoshopu CS6 [29]
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4.7. Priprema slike za web 1 tisak

U Photoshopu se datoteke mogu pripremiti za web na razne nacine, od samog spremanja
slike u rezoluciji potrebnoj za web do dodavanja isjecaka za vezu sa drugim stranicama ili
lokacijama. Isjecci se rade uz pomo¢ alata Slice Tool ili Slice Select Tool a predstavljaju
povrsine pravokutnog oblika. Osim dodavanja isjeCaka, moguéa je i optimizacija slike za
web. Optimizacija je biranje formata, rezolucije i parametara za kvalitetu slike kojom se
postize da slika bude efikasnija, vizualno privla¢na i prikladna za web stranicu. [22] Dva
najkoristenija formata slika na webu su JPEG i GIF. Za slike kontinuiranih tonova koristi se
JPEG format, dok se za jednobojne slike ili one koje sadrze iste povrsine boja koristi GIF

format.
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Slika 4.10. Slice Tool [30]

Za razliku od slika za web, koje su najc¢es¢e u RGB (eng. Red-crvena, Green-zelena i
Blue-plava) modelu boja, slike za tisak spremaju se u CMYK (eng. Cyan-cijan, Magenta-
magenta, Yellow- Zuta, Key-crna) modelu boja. Na ovaj nac¢in dobivaju se sli¢ni rezultati na
ekranu 1 na tiskovnoj podlozi. Takoder se mora odrediti potrebna veli¢ina i1 rezolucija koja ¢e
najbolje odgovarati za potrebe tiska, nakon ¢ega je moguce izraditi probne otiske i vidjeti ako

se tiskana boja poklapa sa zahtjevima tiska.

Slika 4.11. Razlika izmedu RGB i CMYK boja [31]
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5. Kreiranje filmskog plakata

Svaka ideja zapoCinje tzv. Brainstormingom. Brainstorming je metoda pronalaZenja
kreativnih rjeSenja za odredene probleme. [32] No kreiranje neceg novog nije jednostavan
proces. U danasnjem svijetu teSko je stvoriti neSto unikatno §to jo§ ne postoji, pa se sve ceSce
stvaraju sli¢ne stvari. To isto deSava se sa kreiranjem filmova i filmskih plakata, a za svaki
film stvore se najmanje tri razliCite verzije plakata. Svi plakati sadrze osnovne informacije o
filmu: naslov (i podnaslov), popis glumaca, datum izdavanja, izdavaca i sliku likova ili stvari

vaznih za film.
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Slika 5.1. Razli¢iti plakati animiranog filma ,,Minions* [33][34][35]

Zbog toga se ve¢ po samom plakatu moze shvatiti o kakvom je filmu rije¢. Filmovi
pretezito zenske tematike, namijenjeni Zenskoj publici (eng. Chick-flick), na posterima
naj¢esce sadrze parove okrenute ledima ili lezeéi u krevetu. Znanstveno-fantasti¢ni (eng. Sci-

fi) filmovi najCeSée sadrze odi, trileri siluete i sjene te prevladavaju plava ili narancasta

boja.[36]

CRNDYNRN = /v\ P ﬁi'{n‘efunn. .

Slika 5.2. Filmski plakati sci-fi i horor filmova[37]
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Kako bi se stvorio oku privlacan plakat potrebno je znati nekoliko stvari: [38]

1) Za njegovo kreiranje moze se koristiti bilo koji program koji omogucava ispis, a
najbolji su Adobe llustrator i Adobe Photoshop.

2) Postoji mnogo veli¢ina postera koje se mogu koristiti kao npr. 22x28* za pejzazni
oblik 1 14x36% za portretni oblik [39]

3) Koristiti odredenu paletu boja za odredeni film, npr. crvene i crne tonove ako se
radi o vampirima te kombiniraju¢i odredene zasi¢ene i nezasi¢ene, primarne i
suprotne boje

4) Koristiti teksture u pozadini, posebice ako se radi o plakatu sa tekstom

5) Koristiti odredeni font za odredenu tematiku. Takoder, koristiti lako Citljive
fontove, a ako postoji kombinacija, kombinirati 2-3 fonta u odnosima
serifni/sansserifni, deblji/tanji, ve¢i/manji itd. Takoder vrlo je vazno da se font ne
stapa s pozadinom i da bude u kontrastu s njom.

6) Naglasiti vazne stvari, npr. naslov filma, bilo veli¢inom, fontom ili bojom slova ili

sjenama

Prema Webdesigner Depot-u postoji sedam elemenata koje svaki plakat mora sadrzavati

kako bi se istaknuo medu svim ostalima:[40]

1) Pozornost — isticati se medu ostalima

2) lkonografija — pokazati slikama

3) Interes — pobuditi Zelju za filmom

4) Poziv — stvoriti Zelju za gledanjem

5) Stil —izgled dosljedan filmu i povezan s njim

6) Primjena - stvoriti plakat koji ¢e izgledati dobro na svim formatima i
oblicima tiska

7) Prepoznatljivost — naglasiti da se radi o nastavku nekog filma

23



5.1. ldejaiza projektnog plakata

Ovaj animirani film govori o lokalnoj legendi za koju se dosta dugo vjerovalo da je
istinita. Naime, radi se o legendi o zmaju Pozoju koji je Zivio ispod grada Cakovca tokom

osamnaestog stoljeca pa je stoga i naslov samog filma ,,Pozoj*.

Sinopsis filma:

Osamnaesto stolje¢e. Grad Cakovec. Medimursko tlo sve &e§ée se trese, kuce se lagano
njisu, a ljude hvataju strah i1 panika. Gradom kruze glasine kako se to desava jer se zmaj
Pozoj probudio iz svog sna. Ovo jednoglavo stvorenje proteze se od Zupne crkve sv. Nikole
pa do dvorca Zrinskih. U pricama ljudi postoje razlicite teorije o tome. Jedni tvrde da je
zametak nastao od zabe, drugi od zmije, a ima i onih koji vjeruju kako je zametak nastao od
pijetla starijeg od sedam godina. No, samo oni sa bezgrani¢cnom hrabro$¢u usude se uhvatiti u
kostac sa tim stvorenjem. U narodu ipak postoji vjerovanje kako ¢e ovu neman pogubiti vrlo
uden i hrabar dak, grabancija$ iz Cakovca na dan pogubljenja hrvatskih junaka Frana Krste
Frankopana i Petra Zrinskog. Tako se nakon dugi niz godina plemi¢ Matija Cakovecki vratio,
sa zavrSenih dvanaest bogoslovnih Skola i trinaestom negromantskom Skolom, iz Beca u
rodni Cakovec kako bi proveo blagdan Uskrsa sa svojom obitelji. Slusajuéi pri¢e o odvaznom
junaku koji ¢e izazvati Pozoja da izade na povrSinu zemlje i ubije ga, odlucio je osloboditi
svoje sugradane od neprestanog straha te ga sam ubiti. Tako je na dan pogibije hrvatskih
velikana otiSao u srediSte grada, gurnuo mac¢ u zemlju i ¢ekao neman da izade. Ni ne slute¢i,
ubrzo se nasao na ledima ovog stvorenja te jaSuci na njegovim ledima promatrao kako se tlo
njegovog grada pocelo urusavati u zemlju. Zamahnuvsi mac¢em, odrubio mu je glavu i neman
se srusila na zemlju. Matija ma¢em prereZe mrtvu zvijer i podjeli meso sirotinji Cakovca i
svih obliznjih mjesta 1 nasta opce veselje. Tim ¢inom je Matija ubio lokalnu legendu 1
mjestani grada Cakovca mirno su mogli spavati ne bojeéi se vise ogromnog krilatog

stvorenja. [41]
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6. Osnove kreiranja 3D modela

Za modeliranje trodimenzionalnih modela prvo je potreban neki od programa Kkoji
omogucava 3D modeliranje kao npr. Autodesk Maya. Kao §to je ve¢ spomenuto, Autodesk
Maya je jedan od programa koji se koriste za trodimenzionalno modeliranje i u amaterske

svrhe, pa ¢e u ovom poglavlju biti rije¢ o tome.

6.1. Poligonalno modeliranje

Od tri nacina modeliranja u Mayi, poligonalno je najvise zastupljeno. Poligon je 3D
matematicka konstrukcija napravljena od tri ili vi$e tocaka koje imaju X, Y i Z koordinate u
3D prostoru.[1] Osnova svakog poligona je tocka (eng.Vertex). Dvije spojene tocke tvore rub
(eng.Edge), a tri definiraju trokut koji je najjednostavniji poligon. Grupa poligona koja je
spojena svojim tockama nazivaju se elementi, a svaki od poligona koji ¢ine element zovu se

lice (eng. Face).

Slika 6.1. Tri osnovne komponente poligonalnog modeliranja

Svakom elementu u Mayi mogu se mijenjati njegov polozaj i veli€ina te se moze rotirati
koristenjem alata iz alatne trake Select Tool, Move Tool, Rotate Tool, Scale Tool ili pomoc¢u
brzih tipki Q, R, W i E (Q-Select tool, R- Scale Tool, W-Move Tool, E-Rotate tool). Ovi alati
mogu se koristiti na cijelom objektu ili na pojedinim komponentama.

Slika 6.2. Manipulatori objekta



6.2. Maya alati u primjeni

U poligonalnom modeliranju ima mnogo alata i naredbi koje se koriste, no postoji

nekolicina koji su najéesce koristeni. [1]

6.2.1. Maya korisnic¢ko sucelje

Od samog pocetka, korisni¢ko sucelje Maye nije se mnogo mijenjalo. Ono je stvoreno
kako bi olaksalo rad i profesionalcima i poéetnicima. Kao i svaki drugi program, Maya ima
mnoge funkcije kojima se lako moze pristupiti putem izbornika, ikona i brzih tipki (eng. Hot
Keys) te koristi sve tri tipke miSa, posebice za kretanje unutar samog radnog prostora,
odnosno scene. Cjelokupno sucelje moze se podijeliti na pet cjelina. Vrh sucelja zauzimaju
razni izbornici za sve ono §to Zelimo da nam bude prikazano na sceni, desno se nalaze
uredivaci atributa i kanala, ispod se nalaze kontrole za vrijeme, raspon i izvedbu animacije,
lijevo su alati potrebni za rad i pregled prikaza, a u sredini se nalazi radna povrSina. U
glavnom prozoru, odnosno prozoru perspektive (eng. Perspective), nalazi se mreza na kojoj
se rade modeli. Osim perspektive, postoje i pogledi odozgo (eng. Top), bo¢no (eng. Side) i
sprijeda (eng. Front). Svi modeli imaju X, Y i Z koordinate (X-8irina, Y-visina, Z-duljina), a
ikona u donjem lijevom kutu prikazuje koja je koja koordinata $to olakSava snalaZzenje u

prostoru prilikom modeliranja.

Slika 6.3. Korisni¢ko sucelje Autodesk Maya 2012.
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1) Izvlacenje (eng. Extrude)

Nakon stvaranja osnovnog poligonalnog modela kreée se s osnovnim alatima. Extrude
Tool stvara nova lica oko selektiranog lica te dopusta korisniku da njima manipulira. Lica se
mogu rotirati, skalirati, premjestati te se im moze promijeniti smjer na objektu. Ova naredba

nalazi se unutar Edit Mesh izbornika.

Slika 6.4. Skaliranje i promjena poloZaja novonastalog lica

2) Povezivanje (eng. Combine)

Kako bi se povezalo viSe razli¢itih poligona koristi se naredba Combine. Combine
povezuje brojne oblike u jedan oblik, ali ne spaja komponente. [1] Ova naredba nalazi se

unutar Mesh izbornika.

Slika 6.5. Spajanje poligona cilindra sa stvorenim modelom kuce
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3) Spajanje (eng. Merge)

Svaki model moZe biti jednostavniji 1 sadrZzavati manje tocaka i rubova. Ukoliko su neke
toc¢ke suvisne, a nece narusiti geometriju ili izgled modela, mogu se spojiti u jednu. Naredba
Merge trajno spaja selektirane komponente. Ova naredba nalazi se unutar Edit Mesh
izbornika.

Slika 6.6. Spajanje suvisnih tocaka na vrhu krova
4) Dodavanje rubova (eng. Insert Edge Loop Tool)

Insert Edge Loop Tool dodaje horizontalne i vertikalne rubove/crte na poligonalnom
modelu. Osim njega, postoji i naredba Add Devision kojom se dodaju horizontalne i/ili
vertikalne linije u jednakom rasponu. Obje naredbe nalaze se unutar Edit Mesh izbornika.

Slika 6.7. Stvaranje horizontalnih okvira prozora i vrata
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5) Alat za presjek lica (eng. Cut Faces Tool)

Cut Faces Tool dodaje rubove/crte na modelu u svim smjerovima. Ako se zeli dodati rub
na pojedinom dijelu, onda se taj dio (lice) oznaci. Ova naredba nalazi se unutar Edit Mesh

izbornika.

Slika 6.8. Nakon selekcije lica dodaje se presjek vertikalnih okvira

prozora i vrata

6) Izbrisi rub/tocku (eng. Delete Edge/Vertex)

Delete Edge/Vertex trajno briSe poligonalne komponente. Ova naredba nalazi se unutar

Edit Mesh izbornika.

Slika 6.9. Uklanjanje suvisnih rubova i to¢aka
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6.2.2. Teksturiranje pomoc¢u UV mapa

Iako se teksturiranje moze izvrsiti pomocu osnovnih materijala (Shadera) u Mayi, bolji

rezultati se ipak postizu kreiranjem UV mapa. U i V su zapravo koordinate toaka koje se

nalaze na objektu, a program ih koristi kako bi definirao kako ¢e se teksture postaviti na

objektu. UV mape se mogu uredivati unutar Maye ili pomoc¢u dodatnih programa poput
Zbrush, Mudbox i Adobe Photoshopa. [42]

Kako bi se stvorila UV mapa prvo je potrebno selektirati objekt i u alatnoj traci Create

UVs odabrati jednu od vrsta kreiranja mapa.

Tablica 3.1. Tipovi UV mapiranja

Planar Mapping

Projicira UV mrezu kroz ravnu plohu. [9] Planar Mapping najbolje
je koristiti pri objektima koji su relativno ravni ili su vidljivi samo
iz jednog kuta.

Cylindrical Mapping

Izraduje UV tocke za cilindri¢nu projekciju nakon ¢ega se mreza
omotava oko objekta. Ova vrsta mapiranja koristi se za objekte
koji su kompletno zatvoreni ili su okruglog ili cilindri¢nog oblika.

Spherical Mapping

Stvara UV mrezu na temelju projekcije koja se temelji na
kuglastom obliku. Ova projekcija je koristi se za zatvorene oblike
koji mogu biti vidljivi u sklopu okruglog objekta.

Automatic Mapping

Projicira se s tri strane modela ¢ime stvara UV mreZu nakon Cega
se te mreze spajaju u cjelinu 1 prilagodavaju teksturi. Ova metoda
mapiranja je najkorisnija na kompleksnim oblicima.

Create UVs Based on

Camera

Stvara UV mreZe za oznaeni objekt s obzirom na trenutni pogled
kamere. Pogled kamere postaje ploha projekcije na objekt, a
funkcionira na principu planar mapiranja. [9]
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6.2.2.1. UV mapiranje i Adobe Photoshop

Kao §to je ve¢ spomenuto, UV mape se mogu uredivati unutar i izvan Maye. Jedan od
programa koji se Kkoristi za njihovo uredivanje je Adobe Photoshop. Nakon $to se mapa uredi

u Photoshopu, dodaje se kao tekstura Shadera na objektu i time se dobiva konac¢ni rezultat.
Primjer teksturiranja kutije Zitarica pomoc¢u Photoshopa

1. Nakon §to se u Mayi stvori UV mreza nekim od nacina mapiranja, ta mreza se mora
spremiti u format citljiv Adobe Photoshopu. To se radi pomocu opcije UV Snapshot. Nakon
toga se u opcijama ovog alata odabiru naziv i format mape podrzan u Photoshopu (u ovom

slucaju to je .jpeg) te po volji njegova rezolucija.

Image format: | JPEG

¥ UV Range Options

UV range: Mormal (0to 1) -

Reset Close

Slika 6.11. UV Snapshot izbornik
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2. Mapa se u Adobe Photoshopu dodaje isto kao i svaka druga fotografija. U izborniku File >

Open > odaberemo mapu koju smo stvorili.

Slika 6.12. Izgled UV mape u Adobe
Photoshopu

3. Crtovlje, odnosno linije mape u ovom slucaju sluze kao smjernice kako bi se lakSe snalazili
gdje se koje lice nalazi. Da bi stvorili teksturu moramo imati ponajprije teksturu zitarica. Ona
se moze stvoriti rucno ili se preuzeti gotova sa Interneta. Nakon toga odredene dijelove
dodajemo na dio kutije koji ¢e sadrzavati pojedinu teksturu. Pri zavrSetku, uredena mapa se

sprema u odredeni format podrzan u Mayi ( u ovom slucaju to je .jpeg).

Slika 6.13. Dodavanje tekstura na mapu
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4. Kako bi se novo uredena tekstura dodala na model, potrebno mu je dodati materijal. Desni
klik na objekt > Assign Favorite Material > Lambert. U opcijama Lamberta odabere se

dodavanje teksture klikom na ikonu crno-bijelih kockica kod opcije Color > File > odabir

uredene mape.

Slika 6.14. Dodavanje novo uredene mape u Mayi

5. Kako bi se vidio krajnji rezultat pritisne se broj 6 na tipkovnici kojim se prikazuju teksture.

Slika 6.15. Krajnji rezultat
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6.2.3. Renderiranje Mental Rayom

Renderiranje je posljednji korak pri modeliranju. Mental Ray je render kojim se postizu
od kuéne upotrebe do holivudskih primjena za dugometrazne filmove poput filma ,,Hulk* te u
industriji video igara. Osim u zabavnoj industriji, on se Siroko koristi i u arhitekturi i

industrijskom dizajnu za izradu prototipa proizvoda.[43]

Mental Ray nudi Siroki spektar mogucénosti, od izrade specijalnih efekata, animiranih
filmova, vizualizacije virtualnih modela, raznih simulacija do stvaranja sadrzaja za igre.
Takoder, dolazi sa mnogo vlastitih materijala i shadera poput fizickog sunca i neba za

osvjetljenje. [43]

Primjeri osnovnog osvjetljenja i sjencanja u Mental Rayu
1) Global Illumination

Naziv za skupinu algoritama koji daju realnije osvjetljenje u 3D sceni. Primjeri su
refrakcije i sjene jer jedan objekt utjeCe na drugi prilikom simuliranja. Slike renderirane ovim

algoritmima realisti¢nije su, ali raCunalo zahtjeva veliku snagu procesora kako bi ih stvorilo.

—Q

/

Slika 6.16. Global Illumination

34



2) Final Gathering

Koristi se kada je malen broj fotona na sceni, te za ispravljanje istog. lako je smanjeno
vrijeme renderiranje, Final Gathering nadoknaduje po pitanju kvalitete te Cesto dolazi u
kombinaciji sa Global Illumination.

Slika 6.17. Final Gathering

3) Maya Sun and Sky

Jedan je od oblika indirektnog osvjetljenja. To je tehnika osvjetljenja koja oponasa stvarne
uvjete i odnos neba i sunca. [43] Iako ne pruza mogucnost preciznog postavljanja postavki,

prikladna je za simuliranje i osvjetljenje eksterijera.

Slika 6.18. Maya Physical Sun and Sky
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4) Ambient Occlusion

Metoda sjencanja koja se koristi za dodavanje realizma lokalnim refleksijama te pokuSava
oponasati djelovanje svijetla u stvarnom zivotu. Globalna je metoda sjencanja §to znaci da
izratunava kretanje zraka svjetlosti iz svih smjerova prema povrSini. Kao 1 Global
Illumination, povecava kvalitetu zavr$nog renda, ali zahtjeva vecu koli¢inu procesiranja i

time produZuje vrijeme renderiranja.

Slika 6.19. Ambient Occlusion
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7. Prakticni dio

Filmski plakat zapocet je izradom modela u Mayi te njihovog postavljanja na scenu.
Nakon toga uslijedilo je njihovo teksturiranje, postavljanje osvjetljenja i renderiranje. Nakon
toga, renderirane slike koristene su u Adobe Photoshopu kako bi se stvorili filmski plakati i

dobili kona¢ni rezultati.

7.1. Modeliranje

Posto se u pri¢i spominje kako zmaj lezi ispod dvorca Zrinskih, temeljni objekt scene je
upravo dvorac. Za modeliranje dvorca koristeni su ranije spomenuti alati: Extrude, Combine,

Merge, Insert Edge Loop Tool, Cut Faces Tool i Delete Vertex/Face te dodatno Booleans.

1) Modeliranje je zapoceto koristenjem osnovnog poligona kocke iz kojeg je napravljena

kula dvorca.

Slika 7.1. Poligon kocke

2) Na njezinom vrhu, malo iznad samog ruba kule, modelira se jo$ jedan, manji pravokutnik
koji se zatim duplicira (Ctrl+D) 1 povlaci u stranu, stvaraju¢i jednake razmake izmedu

svakog od njih. Taj se postupak ponovi kako bi se stvorili i okomiti pravokutnici.

Slika 7.2. Dodani pravokutnici
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3) Pomocu operacije Boolean stvore se udubine na vrhu kule tako da se prvo selektira objekt

u kojem se zeli stvoriti udubina (u ovom slucaju kula), a nakon toga objekt koji je stvara.

Boolean operacija omogucuje spajanje, oduzimanje i presjek dvaju poligona. Opcija
Union spaja dva poligona, opcija Difference ih oduzima, dok opcija Intersection stvara njihov
presjek. [1]

Slika 7.3. Boolean operacija

Slika 7.4. Opcija Boolean > Difference
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4) Nakon toga stvori se jo$ jedna kocka unutar kule i ponovi se operacija Boolean.

Slika 7.5. Krov kule

5) Koristeéi poligon cilindra i njegovim premjeStanjem napravi se ograda na vrhu kule.

Slika 7.6. Ograda na krovu

6) Nakon krova, na red dolaze prozori. Njih stvorimo takoder pomoc¢u poligona kocke i

operacije Boolean > Difference.

Slika 7.7. Stvoreni prozori
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7) Kako bi kula izgledala bogatije, pomo¢u poligona kocke se dodaju presjeci izmedu

redova, a poligonom piramide se stvore maleni ukrasi izmedu stupaca prozora.

Slika 7.8. Ukrasi na kuli

8) Kako bi izgled kule bio upotpunjen, stvore se okviri prozora i ukrasi na njima. Okviri se
stvore razlikom izmedu dva poligona pravokutnika. Za ukrase se koristi poligon cilindra
na kojem se obriSe polovica rubova pritiskom na tipku DELETE kako bi se dobila

polovica valjka.

Slika 7.9. Stvorena polovica valjka

9) Selektiramo donje lice te u paleti Edit Mesh odaberemo opciju Extrude. Lice povla¢imo
prema dolje te ga suzimo. Selektiraju¢i pojedina lica na novom modelu, ponovimo

operaciju Extrude te skalirajuci i uvlaceci nova lica stvorimo udubljenja na ukrasu.

Slika 7.10. Ukras na prozoru
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10) Nakon stvaranja ukrasa, dupliciramo ga, skaliramo i rotiramo te postavimo na vrh okvira

prozora. Takav gotovi okvir zatim stavimo okolo prozora na kuli.

Slika 7.11. Okvir prozora

Slika 7.12. Kona¢ni izgled kule
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7.2. Postavljanje scene
Nakon §to su stvoreni svi potrebni modeli, na red dolazi postavljanje scene.

1) Ponajprije je potrebno sve stvorene kule dvorca postaviti zajedno kako bi tvorile dvorac, a

nakon toga ureduje se okolina dvorca.

Slika 7.13. Dvorac

Slika 7.14. Pogled na dvorac sa sve Cetiri strane
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2) Pomocu poligona ravne plohe stvorimo tlo ispod dvorca. Odemo u Attribute Editor >
polyPlanel > Subdivision Width i Subdivision Height:50 kako bi plohu raspodijelili na
jednake dijelove Sto ¢e olakSati izradu udubine. Zatim se u alatnoj traci iz izbornika

Poligon prebacimo u izbornik Surfaces.

»  Hode Behavior
P Extra Attributes

Notes: polyPlanel

Load Attributes

Slika 7.15. Podjela plohe na jednake dijelove

3) U alatnoj traci Surfaces odaberemo Subdiv Surfaces > Sculpt Geometry Tool. Pomocu

ovog alata stvorit ¢emo udubinu u kojoj ¢e se nalaziti voda.

Sculpt Geometry Tool je alat kojim se potezom kista lako mogu stvoriti udubine i izbocCine

koje se istim alatom mogu zagladiti, brisati ili se im ureduju tocke. [44]

Slika 7.16. Izrada udubine u plohi
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4) Za stvaranje vode dodaje se jo$ jedna ravna ploha. Zatim se pomocu poligona kocke i
kruznice stvori put do dvorca. Na samom putu dodaju se jo§ modeli kucica kako bi se

scena s modelima dovrsila.

Slika 7.17. Modelirana scena

5) Za upotpunjavanje scene dodat ¢emo par drveéa. Unutar Maye nalaze se gotovi modeli pa
¢e se oni koristiti. Kako bi koristili Mayine modele, u alatnoj traci odaberemo Window >
General Editors > Visor. U Visor prozoru otvori se Paint Effects > trees > poplar.mel.

Ovime se otvara kist kojim na sceni nacrtamo Zeljeno drvo.

] galactic
(] glass

{7 glows

.| grasses
L hair

] liquid

{ markers
.| metal

] objectsMesh
I oils

{ "] paper

{j pastels
o pencils
.| pens

1 plants
] plantsMesh
] teen

| trees

.| treesMesh
7 1 underwater
.| waterMesh
] watercolor

{ weather
.| wetInWet

Slika 7.18. Model drveta

44



6) Kako bi drvo bilo vidljivo prilikom renderiranja, potrebno ga pretvoriti u poligon. U

alatnoj traci odaberemo Modify > Convert > Paint Effects to Poligons.

Slika 7.19. Razlika izmedu Paint efekta i

poligona na sceni

Slika 7.20. Gotova scena
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7.3. Teksturiranje

Kao $to je ve¢ u radu spomenuto, teksturiranje je moguce pomocu adobe Photoshopa.
Postupak teksturiranja jednak je za svaki model kako je prije prikazano u radu, a svi modeli

sadrze iste teksture: teksture cigle, krova i boje zida te Mental Ray materijala Chrome i
GlossyFinish.

1) Nakon stvaranja UV mapa u Mayi, stvaraju se teksture u Photoshopu. Kako bi se stvorila
tekstura cigle koriStena je slika preuzeta sa Interneta koja je u Adobe Photoshopu uredena
osnovnim korekcijama slike. Za promjenu boje se u alatnoj traci alatnoj traci odabere
Image > Adjustments > Hue/Saturation te se promjeni zasi¢enost (eng. Saturation) na -90 i
svjetlina (eng. Lightness) na +20.

Slika 7.22. Tekstura s promijenjenim postavkama
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2) Slijedeci korake dodavanja teksture u Mayi, na dani model se primjene Zeljene teksture.

Slika 7.23. Dodana tekstura cigle

3) Nakon tekstura cigle, slijedi desni klik na model > Faces. Odaberemo lica koja ¢emo

obojiti u bijelo.
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4) Kako bi stvorili sjajni krov na kuli koristi se Mental Ray materijal Chrome. Mental Ray
materijal dodaje se na sljede¢i nacin: desni klik na model (ili u ovom slu¢aju na odabrana
lica) > Assign New Material... > mia_material_x. U Attribute Editoru odaberemo
mia_material_x1 > Presets* > Chrome > Replace. Isti materijal koristi se na ukrasima

okolo kule. KoriStena je bijela boja kroma.

Slika 7.25. Mental Ray materijal Chrome

5) Posljednji korak je dodavanje tekstura prozora. Za prozore je koriSten Mental Ray

materijal GlossyFinish kojem je promijenjena boja u svijetlo plavu s vrijednostima RGB

(197, 237, 255).

Slika 7.26. Teksturirana kula
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6) Na isti nain teksturira se ostatak scene. Teksture krova, trave, vode i kamenog puta

stvorene su koriStenjem slika preuzetih sa Interneta.

Slika 7.28. Teksturirana scena
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7.4. Osvjetljenje i renderiranje

Posto se u radu radi o eksterijeru, kao osvjetljenje koristi ¢emo svijetlo generiranjem sunca i

neba.

1) Za generiranje osvjetljenja sunca i neba otvorimo izbornik renderiranja i kliknemo na
ikonu Render Settings Window. U izborniku Render Using odaberemo Mental Ray.
Ukoliko Mental Ray nije na popisu uklju¢ujemo ga klikom na Window u alatnoj traci >
Settings/Preferences > Plug-in Manager te kod Mayatomr.mll stavimo kvacicu u obje
kucice Loaded i Auto load.

Nakon odabira Mental Raya kao rendera u Kkartici Inderect Lightning odabiremo
Environment > Phyhical Sun and Sky > Create. Generiranjem osvjetljenja sunca i mjeseca

javlja se osvjetljenje koje simulira popodnevno sunce.
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Promjenom smyjera zraka sunca moze se stvoriti efekt izlaska (zrake sunca okrenute od

kamere) i zalaska sunca (zrake sunca okrenute prema kameri) i njihovog osvjetljenja.

Slika 7.30. Osvijetljenje tijekom izlaska sunca

Slika 7.31. Osvjetljenje tijekom zalaska sunca
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2) U Atribute Editoru odabiremo karticu mia_phisicalskyl te promijenimo Haze parametar
na 0.300 kako bi dodali laganu sumaglicu i time smanjili jako osvjetljenje sunca. Nakon
toga renderiramo scenu. U ovoj kartici mozemo mijenjati parametre po volji kako bi

stvorili jaca ili manja osvjetljenja, povecali ili smanjili horizont i njegovu vidljivost i sl.

Par renderiranih fotografija:

N —— ~ -

Slika 7.32. Rend s prve strane

Slika 7.33. Rend s boc¢ne strane
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Slika 7.34. Pogled kroz ulaz

Slika 7.35. Rend sa straznje strane

53



7.5. lzrada plakata u Photoshopu

Koriste¢i neke ranije spomenute alate, dovrsit ¢emo plakat unutar Adobe Photoshopa.

1) Rad zapocinje otvaranjem novog dokumenta (File > New). U otvorenom prozoru biramo
ime rada (u ovom slucaju Filmski plakat) te Zeljenu veli¢inu. Posto ovaj plakat nece biti

otisnut biramo format po volji (u ovom slucaju to je 24*36 incha).

Kako bi pripremili datoteku za tisak velikog plakata potrebno joj je staviti dimenzije B1
papira, 707*1000 mm. Rezolucija potrebna za tisak je 300 piksela po in¢u, a model boja
mora biti CMYK.

2) Nakon dodavanja slike u isti dokument (File > Place... > renderirana scena) spremni smo
za kreiranje plakata. Za jace boje na slici mozemo promijeniti postavke rendera u Mayi ili
uz pomo¢ nekog od alata za korekciju boje u Photoshopu unutar palete Image >

Adjustments.

Slika 7.36. Renderirana slika dodana na plakat
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3) Na isti na¢in dodajemo sliku zmaja preuzetu sa Interneta te nakon smjestanja na Zeljenu
poziciju paletu Layers te desnim klikom na sloj zmaja odaberemo Rasterize Layer kako

bismo mogli vrsiti izmjene na dodanom sloju. Nakon toga pomodu gumice obriSemo

nepotrebni dio.

Koristena fotografija:

Slika 7.37. Koristena slika zmaja [50]

3N
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Y

Slika 7.38. Dodana slika i obrisani nepotrebni dio
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4) Za popunjavanje plakata koristit cemo oblake. Slike oblaka preuzete su sa Interneta.

Koristene fotografije:

Slika 7.39. Koristene slike oblaka [51][52][53]

Slika 7.40. Dodani oblaci
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5) Nakon pozadine na red dolazi tekst. Pomocu alata za pisanje (eng. Horizontal Type Tool)
dodajemo naslov i dodatni tekst na plakatu (datum izdavanja, popis glumaca, producente i

sl.). Na sam naslov primjenjujemo uredenje pomocu Add a layer style iz palete Layers.

Za naslov je koristeni tekst: Berlin Sans FB, Bold, 300pt, RGB (255, 0, 0), a za njegovo
uredenje su koristene opcije Bevel & Emboss gdje je promijenjen kut sjene na 45° i Outer
Glow, gdje su promjenjene opcije Opacity na 100%, koristena bijela boja, Spread: 22%, Size:
3px, iz palete Layers.

o

‘,“‘
H
1

Slika 7.41. Plakat s naslovom
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Za popis ispod naslova koristen je font Eras Medium ITC, RGB (255, 255, 255), 50pt, a za
datum je koristen font Eras Bold ITC, RGB (255, 255, 255), 100pt. Na oba teksta dodana je

sjena pomoc¢u Add a layer style > Drop Shadow.

Dreamworks PRESENTS Pozoj” CRl
MUSIC BY Charies Perry \@

Slika 7.42. Plakat s ostalim tekstom

6) Da bi plakat bio upotpunjen dodajemo logo izdavaca i ostale bitne oznake za film (ovdje:

Real 3D, Dolby Digital, PG).

Za oznake su preuzete fotografije sa Interneta na kojima je promijenjena boja u bijelu. Za
slike u boji su promijenjene svjetlina i zasi¢enje, dok se za crne fotografije promijenila samo
svjetlina. U alatnoj traci odaberemo Image > Adjustments > Hue/Saturation >

Saturation: -100, Lightnes: +100 (za crne fotografije je koriStena samo svjetlina).

KoriStene fotografije:

wDREAMRKs reaLD))3D

PARENTAL GUIDANCE
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Slika 7.43. Kori$tene slike za oznake [54][55][56][57]
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7.6. Konaéni rezultati
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Slika 7.44. Konac¢ni izgled plakata
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Slika 7.45. Druga verzija plakata
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Slika 7.46. Treca verzija plakata
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8. Zakljucak

Tehnologije se razvijaju svakodnevno te se time javlja sve viSe kreativaca. Neki od njih
posebice se zanimaju za podru¢je trodimenzionalnog modeliranja. Trodimenzionalno
modeliranje se od samih pocetaka prosirilo na sva podru¢ja ljudske djelatnosti te se
svakodnevno razvija. Od proizvodne, automobilske i zabavne industrije do obrazovanja,
arhitekture i medicine. Jedan od najéeS¢e koriStenih programa za trodimenzionalno
modeliranje je upravo Autodesk Maya koja se u kombinaciji sa ostalim programima sve vise i
viSe primjenjuje u 3D modeliranju. Upravo ove kombinacije omogucavaju stvaranje
virtualnih svjetova kakve sve c¢eS¢e vidimo na velikim ekranima u kinima. Sa viSe vrsta
modeliranja, teksturiranja i renderiranja, Maya nudi veliki izbor mogu¢nosti od kojih su neki

od cesto koristenih alata predstavljeni upravo u ovom radu.

U kombinaciji sa Adobe Photoshopom, stvorene su teksture modela kako bi oni bili $to
vjernije prikazani. Photoshop, isto kao i Maya, nudi pregrst alata i opcija te svakodnevno
pomaze milijunima ljudi kako bi svoje fotografije doveli do savrSenstva. Njegovi osnovni
alati 1 mogucénosti kao 1 primjer stvaranja tekstura takoder su prikazani unutar rada. Upravo

zbog toga se moze reci kako se koriStenjem Photoshopa uvelike olakSava posao teksturiranja
3D modela.

Photoshop se takoder Cesto koristi kako bi se stvorili razni letci i plakati. No za svako
kreiranje neCeg novog treba slijediti nekoliko pravila koja se moraju poStivati pa tako i za
kreiranje filmskog plakata. Filmski plakat oku postaje privlacan kada se isti¢e od ostalih te u
gledatelju probudi Zelju za filmom. U radu je stoga prikazano kako se na temelju osnovnog
znanja o Autodesk Mayi i Adobe Photoshopu, moze stvoriti scena za animirani film koja se

kasnije koristi za izradu filmskog plakata.

U Varazdinu,

Potpis studenta
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Sveuciliste
Sjever

sVEUZILISTE
SIEVER

1ZJAVA O AUTORSTVU
I
SUGLASNOST ZA JAVNU OBJAVU

Zavrdni/diplomski rad iskljuéivo je autorsko djelo studenta koji je isti izradio te student
odgovara za istinitost, izvornost i ispravnost teksta rada. U radu se ne smiju koristiti
dijelovi tudih radova (knjiga, ¢lanaka, doktorskih disertacija, magistarskih radova, izvora s
interneta, i drugih izvora) bez navodenja izvora i autora navedenih radova. Svi dijelovi
tudih radova moraju biti pravilno navedeni i citirani. Dijelovi tudih radova koji nisu
pravilno citirani, smatraju se plagijatom, odnosno nezakonitim prisvajanjem tudeg
znanstvenog ili strutnoga rada. Sukladno navedenom studenti su duZni potpisati izjavu o
autorstvu rada.

Ja, Vlflx)tbf@\ doglon ¢ (ime i prezime) pod punom moralnom,
materijalnb‘m i kaznenom odgovornoscu, izjavljujem da sam iskljuéivi
autor/ica zavr$nog/diptemskog (obrisati nepotrebno) rada pod naslovom
\Zrodo. Hmwo@ ,ﬂf&todn uE 37%000' Howe (upisati naslov) te da u
navedenom radu nisu na nedozvoljeni natih (bez pravilnog citiranja) koriSteni
dijelovi tudih radova.

Student/ica:
(upisati ime i prezime)

Vla(/(lo h‘ C 0

(vlastoruéni potpis)

Sukladno Zakonu o znanstvenoj djelatnost i visokom obrazovanju zavrine/diplomske
radove sveuéilista su duZna trajno objaviti na javnoj internetskoj bazi sveuciliSne knjiZnice
u sastavu sveuéilidta te kopirati u javnu internetsku bazu zavrsnih/diplomskih radova
Nacionalne i sveuéilisne knjiZznice. Zavrdni radovi istovrsnih umjetnickih studija koji se
realiziraju kroz umjetnicka ostvarenja objavljuju se na odgovarajuéi nacin.

Ja, Hlowdjo Aongeone (ime i prezime) neopozivo izjavljujem da
sam suglaséln/na s javnom objavom zavrsnog/diptomskeg (obrisati nepotrebno)
rada pod naslovom _\Boden blusvos plakates ve paod Nave (upisati
naslov) ¢iji sam autor/ica. T, : Y

Student/ica:
(upisati ime i prezime)

KA
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(vlastoruéni potpis)




	Grad

